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How to Recover a Corrupt Excd File

This wikiHow teaches you how to recover and repair a corrupted Microsoft Excel file on your Windows or Mac
computer. Make sure that you're using a Windows computer. Y ou can only repair an Excel file in the Windows
version of Excel.

Method 1 of 5:

Repairing the File
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Make surethat you're using a Windows computer. You can only repair an Excel filein the Windows
version of Excel.

1. If you'reusing aMac, try one of the other methodsin this article.
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Open Excdl. Its app icon resembles a green box with awhite " X" on it.
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Click [ Open Other Workbooks ). Thisoption is next to a folder-shaped icon in the lower-left corner of
the window.
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Click [ _Browse . It'safolder-shaped icon in the middle of the page. Doing so opens a File Explorer
window.



Select your Excd file. Go to the folder in which your corrupted Excel fileis stored, then click the Excel
fileto select it.

Click the" Menu" icon



. It's the downward-facing arrow to the right of the Open button. A drop-down menu will appear.

Click [_Open and Repair... . Thisoptionis at the bottom of the drop-down menu.
1. If Open and Repair ... is greyed out, make sure that your Excel fileis selected and try again. If it's
till greyed out, you can't repair thisfile.




Click when prompted. It'sin a pop-up window. Windows will begin attempting to repair
your filell

1. If you don't have this option, click Extract Data instead, then click either Convert to Values or
Recover Formulas. Thiswill recover any salvageable data.
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dl Excel was able to apen the file by repairing or remawving the unreadable
content.

Excal campleted file level validation and repair, Some parts of this workbok may have been
repaired of discarded.
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Wait for thefile to open. This may take afew minutesif your Excel fileislarge.

1. If thefile still won't open, go back through this process and click Extract Data instead of Repair
when prompted.
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Save your file. Once the repaired file opens, press Ctrl + S/, double-click This PC, select a save location,
enter afile name, and click Save.
1. Besureto select adifferent file name than the one which you used for the corrupted Excel file.

Method 2 of 5:

Changing the File Type on Windows
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Under stand why the file type matters. Sometimes, Excel documents created on older computers or
versions of Excel become unstable on newer versions; similarly, Excel documents can be saved in many
different file formats. By changing the Excel file format to "xIsx" (or "xIs" for older programs), you can
fix this problem.



Einefox @rigin

Open Start

. Click the Windows logo in the bottom-left corner of the screen.
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Open File Explorer

. Click the folder-shaped icon in the lower-left side of the Start window.



Check the" File name extensions' box. Thisoption isin the "Show/hide" section of the toolbar. Doing
so will allow you to see the file type extensions at the end of files, including your Excel document.

Select your Excdl file. Go to the location of the Excel document that you want to recover, then click the
document to select it.
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Click [ Home . It'satab in the upper-left side of the File Explorer window. Thiswill prompt atoolbar
to appear.
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Click [ Rename . Thisoptionisinthe"Organize" section of the toolbar. Clicking Rename will cause
the Excdl file's name to become highlighted.
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Changethefiletype. Replace whatever comes after the period at the end of the file namewith x| sx
and then press ? Enter .



1. For example, if the document was named " Spreadsheetl.docx”, you would change it to
" Spreadsheet1.xIsx".
2. If thefile extension aready is"xIsx", try using "xIs" or "html".
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Click [ _Yes )Jwhen prompted. Thiswill confirm your changes and change the file extension.
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Try opening thefile. Double-click the file to openit. If the file opensin Excel (or, if you selected "html"
as the extension, a web browser), your file has successfully been recovered.
1. If you chose the "html™ extension, you can convert the webpage into an Excel document by
dragging the html file onto the Excel icon and then saving the file that opens as anew "xIsx" file.
2. If thefile still won't open, proceed to the next Windows method.

Method 3 of 5:

Changing the File Typeon Mac
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Under stand why thefile type matters. Sometimes, Excel documents created on older computers or
versions of Excel become unstable on newer versions; similarly, Excel documents can be saved in many
different file formats. By changing the Excel file format to "xIsx" (or "xIs" for older programs), you can

fix this problem.

Open Finder. Click the blue, face-shaped app icon in your Mac's Dock.



Select the Excel file. Go to the folder in which your Excel fileislocated, then click the Excedl file that you
want to recover.

Click [_File ). Thismenu itemisin the top-left corner of your Mac's screen. Clicking it prompts a drop-
down menu.
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Click [ Get Info . It'sin the File drop-down menu. Thiswill open a pop-up window.



Expand the" Name & Extension” section if necessary. If you don't see any file name or extension
below this category, click the triangle to the left of the "Name & Extension” heading to view thefile's
name and extension.

Changethefiletype. Replace whatever comes after the period at the end of the file namewith x| sx
and then press ?
1. For example, if the document was named " Spreadsheet1.txt", you would change it to
" Spreadsheet1.xIsx".
2. If thefile extension already is"xIsx", try using "xIs" or "html".
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Try opening thefile. Double-click the file to openit. If the file opensin Excel (or, if you selected "html"
as the extension, aweb browser), your file has successfully been recovered.
1. If you chose the "html" extension, you can convert the webpage into an Excel document by
dragging the html file onto the Excel icon and then saving the file that opens as anew "xIsx" file.
2. If thefile still won't open, proceed to the next Mac method.

Method 4 of 5:

Recovering a Temporary Save on Windows
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Under stand the limitations of this method. Like most Microsoft Office products, Excel will
automatically save recovery versions of files, meaning that you may be able to restore a partial version of
your corrupted Excel document. However, Excel doesn't always save these filesin time, and you most
likely won't be able to recover the whole document in this way.
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Open Start



. Click the Windows logo in the bottom-left corner of the screen.
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Typein t hi s pc . Thiswill search your computer for the"This PC" program.
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Click [ _This PC ). It'sthe computer monitor-shaped icon at the top of the Start window. Doing so opens
the This PC window.
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Double-click your computer'shard drive. Thisisusualy the"OS (C:)" option below the "Devices and
drives' heading in the middle of the page.
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Double-click the" Users' folder. You'll find thisin the middle of the hard drive's folder.



Double-click your user folder. Thisfolder islabeled with part or al of your username on your computer.

Double-click the" AppData" folder. It'sinthe"A" section, so you'll most likely find this folder near the
top of the window.
1. If you can't find thisfolder, click the View tab, then check the "Hidden items" box in the
"Show/hide" section to prompt the "AppData’ folder to appear.

Double-click the" Local" folder. Thisoption is near the top of the folder.



Scroll down and double-click the" Microsoft" folder. You'll find it inthe"M" section.

Double-click the" UnsavedFiles' folder. Thisfolder should be near the top of the window.
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Select an Excel file. Look for an Excel file icon that has a name matching your corrupted Excel file, then
click it to select it.
1. If you don't see any files here, arecovery version of your Excel document was not saved.
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Changethe Excel file's extension. To do so:[2]
Click View

Check the "File name extensions" box.
Click Home

Click Rename

Replacethe .t mp sectionwith . x| sx
Press 2Enter .

Click Y es when prompted.
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Open the Excdl file. Double-click the file that you just renamed to open it.
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Save your file. Once the restored file opens, press Ctrl + S/, double-click This PC, select a save location,
enter afile name, and click Save.
1. Besureto select adifferent file name than the one which you used for the corrupted Excel file.

Method 5 of 5:

Recovering a Temporary Save on Mac
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Under stand the limitations of this method. Like most Microsoft Office products, Excel will
automatically save recovery versions of files, meaning that you may be able to restore a partial version of
your corrupted Excel document. However, Excel doesn't always save these filesin time, and you most

likely won't be able to recover the whole document in this way.

@ Finder File Edit

Click [ Go ). Thismenu itemis at the top of the screen. Clicking it prompts a drop-down menu.
1. If you don't see the Go menu item, first open Finder or click the desktop to make it appear.




Hold down the 2 Option' key. After doing this, you should see the Library folder appear in the Go drop-
down menu.
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Click [ Library J. It'sin the Go drop-down menu. Thiswill open the Library hidden folder.
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Open the" Containers" folder. Double-click the "Containers’ folder, whichisin the"C" section of the
Library folder.
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Click the search bar. It'sin the upper-right side of the window.



Click the[ Containers ] tab. You'll find thisto the right of the "Search:" heading near the top of the
Finder window.

Open the" com.microsoft.Excel" folder. Double-click thisfolder to open it.



Open the " Data" folder.

Open the"Library" folder.

Open the" Preferences’ folder. If you don't see thisfolder, scroll down to find it.



Open the " AutoRecovery" folder. Thiswill bring up alist of automatically saved versions of your Excel
files.

Find atemporary version of your Excel file. The temporary version of your Excel file should have some
or al of thefilesnameinitstitle.
1. If you can't find the temporary version of your Excel file, it wasn't backed up.

Select the Excel file. Click the Excel fileto do so.



Click [_File ). It'samenu item in the upper-left corner of your Mac's screen. A drop-down menu will
appear.

Select [ Open With ). Thisoption is near the top of the File drop-down menu. Y ou should see a pop-out
menu open.

Click [_Excel ). It'sin the pop-out menu. Doing so will prompt the temporary version of the Excel
document to open in Excel.



1. Thetemporary version will probably not include some of your most recent changes to the original
Excel document.
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Save the document. Press 2 Command + S/, then enter afile name, select a save location in the "Where'"
menu, and click Save.

Y ou finished reading the article "How to Recover a Corrupt Excel File" edited by the TipsM ake team. We
hope this article has provided you with many useful tech tips and tricks. Y ou can search for similar articles on
tips and guides. Thank you for reading and for following us regularly.
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